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The Dyno2000 Advanced

Engine Simulation Installation

Note: A comprehensive full-color User
Guide is provided with the Dyno2000. This
on-disk documentation can be viewed with
Adobe Acrobat Reader®. See the sidebar
on page 2 for help in installing Reader
software and viewing the User Guide
(D2000MainUsersGuide.pdf on the CD-
ROM).

The Dyno2000 installation is quick and
simple process on virtually all computers. To
minimize the likelihood of problems, review
the following tips before you begin:

1) The Dyno2000 requires Windows 95/98®
or Windows NT and at least 16MB of
installed RAM memory.

2) If you encounter problems installing and
running the Dyno2000, refer to Solving
Problems on page 3.

3) The entire installation of the Dyno2000
and DeskTop Videos requires about
110MB of free disk space. If you wish to
conserve hard-disk space and not install
all the features and extras supplied with
the Dyno2000, select the “Compact” op-
tion presented during the installation pro-
cess.

4) If at all possible, choose the defaults pro-
vided on the installation screens. This
will install the software onto drive C: in a
new Dyno2000 folder.

Installing The Dyno2000
The installation programs included with the

Dyno2000 will copy the appropriate files to
your hard drive. Please read and perform

each of the following instructions carefully.

1)

2)

3)

4)

5)

6)

7

Start Windows95/98/2000 (or Windows
NT), if necessary.

Insert the Dyno2000 CD-ROM into your
CD drive.

A Welcome screen will appear on your
desktop within 5 to 30 seconds (depend-
ing on the speed of your CD drive). If
the Welcome screen appears, proceed
to step 5.

If the Dyno2000 installation Welcome
screen does not automatically display,
run the Setup program included on the
Dyno2000 CD-ROM. (Open the Windows
Explorer, switch to your CD Drive, then
double click on Setup. Alternatively,
choose Settings from the Start menu,
select Control Panels, then double click
on Add/Remove Programs, finally click
the Install button.)

Click Next to proceed to the second In-
stallation screen. Click Next again to re-
view the Motion Software License Agree-
ment. Read the Agreement and if you
agree with the terms, click Next.

Enter your name and company name in
the User Information screen (enter
None for the Company Name if the
Dyno2000 is NOT being registered to a
company). Click Next again to continue
the installation.

The Choose Destination
Location window will sug-
gest C:\Dyno2000 as the
installation path. We recom-
mend that you accept this
default. However, if you pre-




8)

9)

10)

11)

12)

13)

fer another location for the
Dyno2000, click on
Browse... to select a new
path. When you are finished,
click Next to continue.

The Setup Type window will present
three installation options:
Typical—Installs Dyno2000, sample
files, user manual, and software videos.
Compact—Installs Dyno2000, sample
files, and user manual only.
Custom—Allows you to select the in-
stalled elements.

We recommend you select Typical, then
click Next to continue the installation.

The Select Program Folder screen in-
dicates that the Dyno2000 program
folder will be added to the list of Win-
dows Program choices displayed on the
Start, Programs menu. Click Next to
continue.

The Start Copying Files screen gives
you a chance to review all the installa-
tion choices that you've made. Click
Back to make any changes; click Next
to being copying files to your system.

When main program installation is com-
plete, the Setup Complete screen pro-
vides a checkbox option (defaults un-
checked) that allows you to start the
Dyno2000 immediately after installation.
(Note: If you do not check this box and
click Finish, you can easily start the
Dyno2000 by selecting Programs,
Dyno2000 from your Windows Start
menu.) Click Finish to complete the in-
stallation. Note: You may need to restart
your computer.

Starting The Dyno 2000

To start the Dyno2000, open the Win-
dows Start menu, select Programs, then
choose Dyno2000, and finally click on
the Dyno2000 Engine Simulation icon
that appears within the folder. See page
5 thru 16 for more information about
Dyno2000 program features.

A video of the entire DeskTop line of
performance software has been included
with the Dyno2000. Start the demo by

90-Page Full-Color Users Manual

www.motionsoftware.com
support@motionsoftware.com

The Dyno2000 is packed with features
to help you test engines and locate the
best parts combinations for virtually any
application. This QuickStart guide will get
you going, but to help you apply all the
capabilities of this powerful engine simu-
lation, a 114-page, full-color, on-disk User
Manual has been included with this soft-
ware. The Users Manual is easy-to-ac-
cess and will show you how to get the
most from the Dyno2000. You'll learn
about every menu selection, program
function, Iterative testing, and much more.

After installing the Dyno2000, you can
read the User Manual by using any of
these options: 1) Open the Help menu in
the Dyno2000 and select User Manual.
2) Open the Windows Start menu, se-
lect Programs, then choose Dyno2000,
and finally click on the Users Manual
icon that appears within the folder. Or 3)
double click on the file
D2000MainUsersGuide.pdf located on
the Dyno2000 CD-ROM (in the root di-
rectory).

IMPORTANT: If any of these techniques
fails to open the Dyno2000 on-line docu-
mentation, you need to install Adobe
Reader on your computer by double click-
ing on the reader installation file that you'll
find in the Acroread folder on the
Dyno2000 CD-ROM. Simply double click
on the AR3W95.EXE file located in the
Acroread folder to install Adobe Reader
on Windows95/98/2000 & NT systems.




opening the Start menu, se-
lect Programs, choose the
Dyno2000 folder, then click
on DeskTop Software. If
you do not see the DeskTop
Software icon, read the following note.
Note: If you did not install the videos in
Step 8, you can still run the demos by
double-clicking on the DeskTop
Software.exe file located in the
DeskDemo folder on the Dyno2000 CD-
ROM.

14) If you have problems installing or run-
ning the Dyno2000, please take a few
minutes to look over the following
sources of information before you con-
tact technical support:

e The Solving Problems section and the
remaining information that follows in this
QuickStart guide.

e The FAQs in the On-Line User Manual
(see sidebar on previous page for tips
on installing and reading the User

Guide).
« Visit the Tech Support section of the Mo-
tion Software website at

www.motionsoftware.com.

If you cannot find a solution to your prob-
lem by reviewing these materials, print out
and return the fax-back form in the on-disk
User Manual. Fax or mail the completed form
to:

Motion Software, Inc.

535 West Lambert, Bldg. E

Brea, CA 92821-3911

Tech Fax: 714-255-7956, or visit our

Web: www.motionsoftware.com
You may also contact Motion Software Tech
Support at the email address:
support@motionsoftware.com

NOTE: Tech support will only be provided to
registered users. If you did not purchase the
Dyno2000 directly from Motion Software,
make sure you send in your registration card
today.

Solving Problems

Question: Received an “Error Reading
Drive D” (or another drive) message
when attempting to install the Dyno2000.
What does this mean?

Answer: This means your computer can-

not read the disk in your CD-ROM drive.
The disk may not be properly seated in
your drive, the drive may be defective,
or the disk may be damaged. If you can
properly read other CD-ROM disks, but
the Dyno2000 distribution disk produces
error messages, contact Motion Soft-
ware, Inc., for a free replacement (ad-
dress above).

Question: An error message was dis-
played during the installation process.
What should | do?

Answer: Turn off all virus protection soft-
ware, restart your computer, then retry
Dyno2000 installation.

Question: The Dyno2000 displayed an As-
sertion Failure error while | was perform-
ing an engine simulation.

Answer: Please note down all of the in-
formation presented in the message box,
provide a quick synopsis of what lead
up to the error, then send this informa-
tion to Motion Software. Visit the Motion
Software website to check for periodic
Dyno2000 updates and patches
(www.motionsoftware.com). Thank you
for your assistance in improving the
Dyno2000.

Question: What do | do when | receive an
error message when starting the
Dyno2000?

Answer: The issue you have is due to a
bug in the early versions of Windows95.
We have sidestepped this issue with re-
lease 3.08+. You can upgrade your ver-
sion of the Dyno2000 to the latest ver-
sion by visiting our website
(www.motionsoftware.com). Assuming
your version of the Dyno2000 is 3.05:
Download and run the 3.05-t0-3.06 patch
to upgrade to 3.06, then download the
3.06-t0-3.07 patch to upgrade to 3.07,
and finally download the 3.07-to-3.08
patch to upgrade to 3.08.

Question: The Dyno2000 calculated the to-
tal Combustion Volume at 92ccs. But |
know my cylinder heads have only
75ccs. What's wrong with the software?

Answer: This confusion comes from as-
suming that the calculated Total Com-
bustion Volume displayed in the com-
ponent-selection screen is the same as
your measured combustion-chamber vol-
ume. The Total Combustion Volume is
the entire volume that remains in the
cylinder when the piston reaches top



dead center. See the User
Manual for more information
about compression vol-
umes.

Question: When | choose a
carburetor that is too large for an engine
(for example 1200cfm on a 283 Chevy),
why does the power increase without a
“bog” at low speeds?

Answer: The Dyno2000 cannot model
over-carburetion and show the usual re-
duction in low-end performance that this
causes. In reality, carburetors that are
too large for an engine develop fuel at-
omization and air/fuel ratio instabilities,
phenomena that is carburetor specific
and extremely difficult to model. The
Dyno2000 assumes an optimum air/fuel
ratio regardless of the selected CFM rat-
ing. While the program produces posi-
tive results from larger-and-larger induc-
tion flows (by the way, this is not far
from reality when optimum air/fuel ratios
can be maintained, as is the case with
many fuel-injection systems), you can’t
go wrong if you use common sense
when selecting induction/carburetor flow
capacities.

Question: The engine | am building uses
two 660-cfm Holley carburetors. How can
| simulate this airflow?

Answer: To simulate two, 660cfm, 4-bar-
rel carburetors, simply add the airflow
and enter the total 1320cfm value into
the component-selection screen at 1.5-
inHG pressure drop.

Question: The horsepower predicted when
| enter the seat-to-seat timing on my cam
card does not match the horsepower
when | enter the 0.050-inch timing fig-
ures for the same camshaft. Why are
there differences?

Answer: The Dyno2000 uses the timing
specs found on your cam card, and in
cam manufacturer’s catalogs, to develop
a valve-motion curve (and from this, de-
velops the instantaneous airflow for each
port). Whenever possible use seat-to-
seat timing figures (called advertised
duration). They provide the Dyno2000
more information about valve motion at
low lifts, and will produce more accurate
simulated power levels.

Question: The Dyno2000 displayed an er-
ror message “The Dyno2000 was un-
able to complete the simulation...” What

went wrong?

Answer: The combination of components
you have selected produced a calcula-
tion error. Try reducing the EVO timing
specs, increasing the induction or su-
percharger flow, lengthening the stroke,
selecting a cam with less duration, or
reducing the compression ratio. A bal-
anced group of components should not
produce this error.

Question:  When | run a simulation, part of
the graph curves don’t appear on my
screen. What can | do to correct the dis-
play?

Answer: Open the Graph Options menu
(right-click on the graph) and select Auto
Range for the Y1 and Y2 variables. See
the pages 9 & 10 for more information
about graph scaling and plotting vari-
ables.

Question: | cannot get Desktop Drag ver-
sion 2.8.7 to properly import an engine
file from the Dyno 2000 version 3.08.

Answer: To import an engine from the
Dyno2000 into the DragStrip (all Dos ver-
sions), you must first EXPORT it using
the EXPORT-TO-DOS function located
in the File pull-down menu within the
Dyno2000. This converts the DYN file to
a format that is readable by the (Dos)
DragStrip program (see page 13 for more
information). These steps will not be nec-
essary when importing Dyno2000 en-
gines into the Drag2000 Windows
dragstrip simulation (scheduled release
5/1/00).

Question: | recently ordered your Dyno
2000 software. When | tried to install
Quicktime 4.0 from the CD, | was
prompted to enter a Registration Num-
ber. What number to | enter?

Answer: The request for a registration
number is an Apple Computer request.
It allows individuals that have purchased
the “Pro” version of QuickTime to acti-
vate those features (these features are
not required to view the video files on
the Dyno2000 CD). When you are pre-
sented with the request for a name and
registration number, just leave all fields
empty and proceed with the installation.
A free version of QuickTime will be in-
stalled.

Dyno2000, Version 3.08, Release 4, 3/00
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The Dyno2000 Feature Overview

Note: A comprehensive full-color User
Guide is provided with the Dyno2000 that
details program features and usage. This
on-disk documentation can be viewed with
Adobe Acrobat Reader®. See the sidebar
on page 2 for help in installing Reader
software and viewing the User Guide
(D2000MainUsersGuide.pdf on the CD-
ROM).

THE MAIN PROGRAM SCREEN

The Main Program Screen allows you
to select engine components, dimensions, and
specifications. In addition, engine power
curves and/or simulation data is displayed in
graphical and chart form. The Main Program

Program Menu Bar Title Bar

Drop-Down

Tool Bar \\ \M/enu

Screen is composed of the following ele-

ments:

1) The Title Bar displays the program name
followed by the name of the currently-
selected engine.

2) The Program Menu Bar contains eight
pull-down menus that control overall pro-
gram function. Here is an overview of
these control menus, from left to right
(additional information on menu functions
is provided elsewhere in this guide):
File—Opens and Saves dyno test files,
exports DOS Dyno files to other Desk-
Top software, prints engine components
and power curves, allows the quick se-
lection of recently used Dyno files, and
contains an exit-program function.
Edit—Clears all component choices from

the currently-selected engine (indicated

Vertical Divider To
Resize Left/Right Panes

F R E]| (2| \
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Categories e i )
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Engine e g L = Engine
Selection ek e "cc N
Tabs \ Y Tl wen 5 — s, RS | Comparison
e Drele — Curves
= :...u.,n".. s -
Left pane Right Pane Display Tabs
Display Tabs Range Limits

And Status Box




Program Menu Bar

E)

The Program Menu Bar contains drop-
down menus that control Dyno2000 func-
tion. Each menu is described below.

3)

by the Engine Selection Tab currently in
the foreground; see Engine Selection
Tabs on page 7).

View—Allows you to turn the Toolbar,
Status Bar and Workbook layout on or
off.

Simulation—Run forces an update of
the current simulation. Auto Run enables
or disables (toggles) automatic simula-
tion updates when any engine compo-
nent is modified.

Units—Selects between US and Metric
units.

Tools—Opens the lterative Testing win-
dow or selects one of the built-in, en-
gine-math calculators.

Window—aA standard Windows menu for
arranging and selecting engine display
screens.

Help—Gives access to the Users Guide,
and other program help features.

The Engine Component Categories
are made up of the following groups:
SHORTBLOCK—Select the bore,

Incomplete Component Fields

B in
’:E|Iylnders: """\ Lyl val: \

SHORT BLOCK

lock: = Bore: = Stroke:  *%in

Total \u"yf’

[EICYLINDER H_E:‘PS Empty Component
Cylinder Heads: / X
At Flow Fle: == Fields
Intake Wakees == Exhaust Walves: =
IntakeWakee: = in Exhaust Valve: == in

t

COMPRESSION y 4
ompression Aatio; =

Combustion Space:

E

[®[INDUCTION
Induction Flow: *** cfm & inHg Fuel: ==
Manifold Type: == M20: == |bs/min
Blower: Hore Intercooler: %
Flow: % cim Pressure Ratio: Boost Limit: # pai
Speed. * rom Belt Gear R atio: Surge Flow: % cfm

ff: =% Internal Gear Ratio: <

All Components

stroke, and number of cyl-
inders in this category.
CYLINDER HEADS—Se-
lect the cylinder head type,
port configuration, and
valve diameters. Direct entry of flow-
bench data is also supported.
COMPRESSION—Select the compres-
sion ratio.

INDUCTION—Selects the airflow rate
through the induction system, the type
of fuel, nitrous flow rate, intake mani-
fold, and a forced induction system.
EXHAUST—Selects the exhaust-system
configuration.

CAMSHAFT—Selects the camshaft
type, lifter type, and allows direct entry
of valve timing and lift data.

NOTE: Each component category con-
tains a Status Box located in the upper
left corner. These boxes either contain a
red boxed X, indicating that the category
is not complete (inhibiting a simulation
run), or a green-boxed check-mark 0O,
indicating that all components in that cat-
egory have been selected. When all
component categories have green
checks, a simulation will be performed
using the current data values and the
results will be displayed in the graphs
on the the Main Program Screen (the
simulation and data plot will occur auto-

Component Status Boxes

Ly [ COMPRESSION

Selected / Compression Ratio: 11.00
Ly (3] INDUICTION
category | [[lndction Flow: 7600 cin @
Incomplete

Manifold Type: Forced Induc

Blower: MNane

Flow: % cfm Prezsure]

Speed: % pm Belt Geq

Eft: 5 Internal
[¥|ExHALIST

Exhaust Systern: Forced [mdu
| CAMSHAFT

Camszhaft Tupe: High Perfarm.

Lifter: Faller

All component categories start off empty, indicated by strings of asterisks (***) next
to each incomplete selection. Move the mouse cursor into any category and double
click the left mouse button on the asterisks to open the component-menu bounding
box. When all selections within a category are complete, the red X will change to a
green checkmark.



Drop-Down Component Menu

| COMPRESSION

Caompreszion B atio

siBounding ggg} '\\
Induction Flow: B%g(‘:fm @1 o :as&
Manifold Type:  Forced Inductig ggg:} L0 lgse
Blower: Turbo-ir He?%%t 1b_gﬁ:1 oleM’eiq u
Flowe:  300.0 cfm TessUle FAGt: Limnit: 10.0 pzi

105801

Speed: Current: Flow: 2000 cim

Eff: F20% Selrér&i FéaH:h

+|EXHAUST
Exhaust Systen:

7| CAMSHAFT

E_amshaft Type: High Performance 51 14004
Lifter Raller

Cam Specs @ Seat-To-Seat 14.50:7 o
Int Lift@atve: 04650 [Auta] BT
EvhLit@valve: 0.441in  [Auta) U
Mominal Timing 16.00:1

125601
13.00:1
135601

A Ret) 0.0

A component-bounding box will permit
direct numeric entry or drop-down menu
selection. Click on the red-X to close the
box without making a selection.

matically providing Autorun is checked
in the Simulation drop-down menu, see
Simulation Menu description, above).

4) The Drop-Down Component Menus
contain components and specifications
for each of the Component Category
choices. Click on any component speci-
fication to open its menu. The menu will
close when selection is complete. If you
wish to close the menu before making a
new selection, click the red X or press
the Escape key until the menu closes.

5) Several Component Category menus
allow direct numeric entry (see photos
on page 8). During this data entry, the
range of acceptable values will be dis-
played in a Range Limit Line within the
Status Box at the bottom of the screen.

6) The Dyno2000 can simulate several en-
gines at once. Switch between “active”
engines by selecting a Tab from the En-
gine Selection Tabs, just above the Sta-
tus Box. The currently-selected engine
is indicated on the foreground Tab. The
name of the currently-selected engine is
also displayed in the Title Bar.

7) The Main Program Screen window is di-
vided into two panes (the width of these
panes is adjustable; drag the vertical
screen divider to resize). Each pane con-
tains a Screen Display Tab group (Both
right and Left Pane Display Tabs are
provided). Use these tabs (see illustra-

tion on page 5) to switch
the display in each pane to
component lists and/or vari-
ous graphic data displays.

8) Use the Vertical Divider to
resize the right and left panes. By drag-
ging this divider to the right or left bor-
der, you can display any graph in a “full-
screen” mode (see photo, page 8).

9) The Current Engine Power Curves dis-
play the horsepower and torque for the
currently-selected engine. Horsepower
and torque are the default curves, how-
ever, the data displayed can be changed
by right-clicking on the graph and reas-
signing each curve in the Graph Op-
tions Box. Use the Properties... in the
Options Box to setup comparisons be-
tween any “active” engine.

10) The Main Program Screen also incorpo-
rates Windows Size Buttons. These
buttons provide standard maximizing,
minimizing, and closing functions com-
mon to all windows. Refer to Windows
documentation for more information on
the use of these features.

DIRECT-ENTRY MENU CHOICES

The Bore, Stroke, Number Of Cylinders,
Valve Size, Compression Ratio, Induction Air-

ane Display Tabs

R
N
&

Use the Right and Left Pane Display Tabs
to select component lists, tables of re-
sults, or graphic data listings. Here the
left and right panes have been set to dis-
play graphs, each with unique engine
variables (HP and Torque in the right
graph and Manifold Pressure and Volu-
metric Efficiency in the left graph).
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Use the Vertical Divider to resize the right
and left pane displays. To view either
pane in full-screen mode, move the di-
vider to the right or left margins.

flow, and several other menus permit direct
numeric entry. When a component field sup-
ports direct entry, the bounding box will have
a white interior. If the only selection possible
is a choice from the drop-down menu, the
bounding box will have a gray interior (see
photos). Choosing a new value will replace
the currently displayed value. When you press
Enter (or click on another component) the
new value will be tested for acceptability, and
if it passes, it will be used in the next simula-
tion run. If you press Enter without entering
a new value, the currently displayed value is
left unchanged.

Data entry into any field in the compo-
nent-selection screen is limited to values over
which the Dyno2000 can accurately predict
power. The range limits are displayed in the
Range Limit Line within the Status Box at
the bottom-left of the Main Program Screen.
If you enter an invalid number, the Dyno2000
will play the Windows error sound and wait
for new input.

For example, to make direct numeric
entry for engine Bore, double-click on the
current Bore value (or use the Tab and Shift-
Tab keys to move the bounding box to the
Bore field and press Enter). The range limits
for Bore will be displayed in the Range Limit
Line (2.800- to 7.000-inches). Make an entry
within the acceptable range followed by En-
ter. If you selected an invalid number, the
Dyno2000 will sound an error tone and wait
for a new numeric entry.

THE RESULTS DISPLAYS

The speed and ease of en-
gine component entry in the
Dyno2000 is complemented by
the power and versatility of the simulation
results displays. Almost the same instant that
all the component categories have been com-
pleted (all categories have green Status
Boxes) the simulation results will be displayed
on fully-scalable precision graphs. The dis-
play graphs are customizable to plot virtually
any engine variable on any axis. Auto scal-
ing or manual axis scaling is easily setup by
right-clicking on the graph. Up to four en-
gines can be compared at once. And a com-
prehensive “table” display shows exact horse-
power, torque, rpm, induction pressure, cyl-
inder pressure, engine friction, and more! The

Fields Acceptmg Numerlc Input

| COMPRESSION

Compression B aticd10. v B

<|INDUCTION S

Induction Flowe: BO0.0Ycfm & 3.0100 ggg:: b azoline
MR fféeBEEﬁ%]I%uﬁtﬁ'a : 9501 (OESHF
Blower: Tubo- Nutaerichiffput 10.00:1 oler: % %
Flow: 245 lagoepteds Enter: 10,501 Lirnit: 10.0 psi
Speed: value=6F miake™ 19,001 Flove: 105.0 cfm
Bt TTD Zseledtivitfrom ' 11501

< ExHalldrop-down menu. 12.00:1

Exhaust System: 12501

o | CAMSHAFT Egg:‘l

E.amshaft Type: Stock Street/Econo 14,001

Lifter: Hyd. T

Cam Specs @ Seat-To-Seat 14.50:1 i3

Int Lift@alve: 0390in  (Auto] ]

Exh Lift@alve: 0370 1n  [Auto) T

Marminal Timing 16.00:1 [+].-"F|et[] oo

Fields Only Acceptmg Menu Input

| INDUCTION

Induction Flow: BO0.0 cfm & 3.0 inHg Fuel: Gazaline
tanifold Type|Forced Induction i L AL8) 120 0.0 1bs/min

Single-Flane k arifold

Blower. Turbo- Aifeesearch TB3I )
Flow:  245.0 cfrr|  Pressure Ra ?uaI'P:T:?E M;nm.:fulc:d 3i
G Rl unhiel-Fam hanifol -
@Fg’\)}ﬁl ckg ’th??ﬁe Individual Runner L F.)
ﬂme” FHB Tuned Port Injection

+ ExHiladcepted. Make
Exhaust Siselection from

7 capdroprdown menu.
Camzhaft Type: Stock Street/Economy  Cam File: =
Lifter: Hyd. Lobe Center:

Am Specs w3 Seat-To-Seat alve Dverlan:

Sequential-Fire Injection
Forced Induction

The bounding boxes, activated when you
double click on any component field, will
accept direct numeric entry (top) or only
menu selections (above).
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Simulation results can be displayed in
chart or graph form. Either pane (the left
or right) can be selected to display re-
sults using the Pane Display Tabs.

Dyno2000 will show you what you are look-

ing for, fast!

The Simulation Results display is com-
posed of several elements that will help you
retrieve the most information from any simu-
lation as quickly and easily as possible:

1) The Main Program Screen is divided into
two sections (called panes), with the
component selection categories on the
left and the results screen on the right
(by default). The center divider between
each pane can be moved (click and drag)
to increase the size of the results screen

Simulation Results Display

HP ftbs

to suit your requirements.
The graph will redraw and
rescale to take advantage
of changes in display area.

2) The results graph consists
of three axis, a left, right, and bottom
(horizontal) axis. Each of these axis can
be assigned an engine variable. Currently
the Dyno2000 will graph the following
variables: Rpm, Horsepower, Torque,
Intake Manifold Pressure, Volumetric
Efficiency, Imep (Indicated Mean Effec-
tive Pressure), Bmep (Brake Mean Ef-
fective Pressure), and Fmep (Friction
Mean Effective Pressure). Right click on
the graph to display the Graph Options
menu to assign engine variables to graph
axis.

3) The results graphs support several meth-
ods of axis scaling. Each axis will scale
to a low, medium, and high value. Plus
auto-scaling can be enabled for any axis.
By default, auto-scaling is turned off. This
maintains the axis values constant, es-
tablishing a fixed baseline so that
changes in power or torque are easily
distinguished. However, when compo-
nent changes dramatically alter power
(like Nitrous Oxide or forced induction),
the auto-scaling feature will ensure that
the data curves are always visible and
display at 80 to 90% of full graph height
for maximum resolution.

4) The Graph Properties dialog screen
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The results graphs each consist of three
axis, a left, right, and bottom (horizon-
tal) axis. Right click either graph to as-
sign any variable to any curve.
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This graph shows how horsepower (red)
and manifold pressure (green) varied as
engine speed changed throughout a test
run. Also note that the screen divider
has been moved to allow the graph to
draw a more detailed display.



Compare Up To 4 Engines
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A comparison of four engines was setup
using the Properties Box. Up to four
“open” engines can be compared on
any graph. This graph shows how
horsepower and volumetric efficiency
varied for four test engines.

allows on-graph comparison of up to four
engines at once. The engines you wish
to include in the comparison must be
“open” with active tabs in the Engine
Selection Tabs display. Right click the
graph to display the Graph Options

Default Scaling

HP ftibs

menu then select Proper-

ties. Use the Graph Data

Sets drop-down menus to

select from currently-open

engines. When you click on

OK, the graph will redraw with the de-
sired data comparisons. A legend at the
bottom of the graph provides a key to all
graph curves.

5) In addition to 2D graphing capability
described above, a chart display is avail-
able by clicking on Table tabs located at
the bottom of the right and left panes.
The table lists all engine variables re-
corded during the simulated dyno run.
The exact data values are displayed in
500rpm increments from 2000 to
11,000rpm.

THE DYNO2000 ITERATOR™

The Dyno2000 brings not only the awe-
some power of engine simulation computa-
tions to the desktop, but also the ability to
sort, compare, and select from hundreds,
thousands, even millions of dyno tests and
isolate the best combinations based on your
selection criterion. Using powerful, built-in

Auto Scaling Option
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The results graphs support several methods of axis scaling. Each axis will scale
to a low, medium, high, and auto-scale ranges. Fixed-axis scaling maintains the
axis values, establishing a fixed baseline so that changes in power or torque are
easily distinguished. When changes dramatically alter power, the auto-scaling
feature ensures that the data curves will always be visible and display at 80 to 90%

of full graph height.



The Dyno2000 /terator™
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Using powerful, built-in lterative Test-
ing ™, the Dyno2000 can test more parts
combinations than any human could
sort and file. It will carefully analyze all
the results and present the best for you
to review.

Iterative Testing, the Dyno2000 can test more
parts combinations than any human could sort
and file. It will carefully analyze all the results
and present the best-of-the-best for you to
review. The Dyno2000 Iterator handles all
testing details. In fact, you can start a series
of tests and simply walk away from the com-
puter until the task is complete. Or you can
continue to use your computer for other tasks
while it performs dyno testing and analysis in
the background.

Setting Up lIterative Testing

After all components have been selected
and at least one dyno test has been per-
formed, you may setup lterator Testing by
selecting it from the Tools menu. Initially, the
Main Iterator Screen is displayed (it will be
empty if this is the first time you've opened
the Iterator since you started the Dyno2000).
Select the Setup button to open the Iterator
Setup dialog box. The Setup box allows you
choose the range of components to use for
Iterative testing. Start off by selecting a
baseline engine from the Baseline Engine
drop-down box. Every “open” engine that has
all component categories completed is avail-
able for Iterative testing. When you have se-
lected a baseline engine, the Numeric Pa-
rameters menus will become active. Select
an Engine Parameter to test (bore, stroke,
and compression, etc.) and/or select any of
the Cam Parameter menus.

When you select a testing parameter,
range boxes are displayed and loaded with

the current component value.
Enter the value range for each
engine parameter (always enter
the smaller value in the left box
and the larger value in the right
box) and the Step Value to use throughout
the test run. The smaller the Step Value, the
more tests will be performed. The Number
Of Steps (#Steps) for each parameter is dis-
played to the right of each parameter field.
The total number of steps for the lterative
test can accumulate quickly, since it is deter-
mined by multiplying together all the Num-
ber-Of-Step values.

Cam timing values are selected from the
Cam Parameters category. Again, when each
timing value is selected, such as IVO, the
current value for that timing point is loaded
into the parameter range boxes. Select the
minimum and maximum values for each tim-
ing point (always enter the smaller value in
the left box and the larger value in the right
box), then select a step value. #Steps will be
displayed.

When all components, ranges, and step
values have been selected, next choose
whether you would like to search for Maxi-
mum Power or Maximum Torque in the Best
Results Criterion box. Then, select the Mini-
mum and Maximum RPM values that the

Completed Setup Screen

Iterator Setup [ %]

Baseline Enaine: | StockSmallblock,dyn ¥

~ Numeric Best Result Cr
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After selecting a baseline engine the
Numeric Parameters menus become ac-
tive. Select Engine Parameters, a test-
ing Range, and the Step Values to use
for the test series. Then select whether
you would like to search for peak Power
or Torque in the Best Results Criterion
box. Finally, select the Minimum and
Maximum RPM range through which
engine output will be evaluated.



Testing In Progress
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Begin Iterative testing by clicking the
Run button. As each test is completed,
the engine power or torque curve will
be displayed in the small Current Test
Result graph. As testing proceeds, the
ten component combinations that pro-
duce the best power or torque within
the selected rpm range are “stored” in
the Best Results 3D graph. View the
curves (red curves indicate Horsepower;
green curves indicate Torque) from any
prospective using the X+, X-, Y+, Y-, Z+,
and Z- buttons (Home returns the graph
to original position).

Dyno2000 should use to search for the best
horsepower or torque (rpm range must span
least 500rpm). For example, you might se-
lect 2500-3000rpm in a search for maximum
torque on a powerplant for a heavy vehicle
or for towing applications. On the other hand,
a selection of 7000-7500rpm might be used
in a search for maximum horsepower on a
race engine.

When you have completed all the selec-
tions on the Setup dialog, click OK to close
the box and return to the Main Iterator Screen.
Notice that the total number of tests in the
current Iterator run is displayed in the Iterator
Status box (upper left). Begin Iterative test-
ing by clicking on the Run button. As each

Iterative test is completed, the
engine power or torque curve
will be displayed in the small
Current Test Result graph
(red curves indicate Horse-
power; green curves indicate Torque). As
testing proceeds, the ten component combi-
nations that produce the best power or torque
within the selected rpm range are “stored” in
the Best Results 3D graph.

When lterative testing is complete (you can
stop testing at any time by pressing the Halt
button; press Run again to continue testing),
the Best Results graph will contain the ten
engine combinations that achieved the high-
est horsepower or torque within the selected
parameter and rpm ranges. View the curves
from any prospective using the X+, X-, Y+,
Y-, Z+, and Z- buttons (Home returns the
graph to original position), then place check
marks next to the curves you wish to keep in
the Keep Result box. You can keep all ten
curves by clicking on Keep All. When all
curves you wish to keep have been selected,
click OK to close the lterator. In a few sec-
onds, the Dyno2000 will spawn dyno-test en-
gines with component combinations that pro-
duce the power or torque of the selected
curves.

When the lterator closes, the new spawned
engines will be displayed in the Engine Se-

Iterator Spawned Engines
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When the lterator closes, spawned en-
gines will be created and displayed in
the Engine Tabs at the bottom of the
Main Program Screen. The comparison
test shown here between the Baseline
engine and one of the ten test results
illustrates the increase in power and
torque that was “found” by the lterator.



lection Tabs at the bottom of the Main Pro-
gram Screen (see page 7 for more informa-
tion on Engine Tabs). Each test engine can
be brought into the foreground by clicking on
its Tab. lterator-spawned engines can be
analyzed, tested, and modified in any way,
just like any other engine in the Dyno2000.
In fact, it is possible to begin a new Iterator
test using any of the spawned engines as a
Baseline Engine to further “home in” on the
desired results.

Tips For Running Iterative Testing

The best way to find optimum components,
especially cam timing, is to use large step
values (5 degrees or more) to “get in the
ballpark” of the right values. Then run a sec-
ond lteration series keeping the range of
values narrow (perhaps just a 5 or 10 degree
range) but using smaller (perhaps 1 degree)
step values to zero-in on precise timing.

Narrowly-focused tests may still require
several thousand test cycles to complete. A
series this large may require an hour or two—
or even a day or two—of calculation time
depending on the speed of your computer. In
these cases, you may continue to use your
computer to perform other tasks. Simply use
the Start menu to begin other applications
and use Alt-Tab to switch between applica-
tions (see your Windows documentation for
more information on program switching). If
you are running Windows98, you may select
the “DeskTop” icon in the task bar (usually
located two or three icons to the right of the
Start menu on the task bar) to “minimize” the
Dyno2000 and regain your desktop.

EXPORTING DYNO FILES

Programs within the DeskTop Software
series allow you to simulate building and dyno
testing an engine, then you can install any
(simulated or real) engine in a vehicle and
test the combination in 1/8- or 1/4-mile drag
events in the DeskTop DragStrip and
Drag2000. You can even load simulated en-
gines into DeskTop ProDrag Racing, Intense
Imports, and X-Car Road Racing games. It is
Motion Software’s goal to maintain this com-
patibility throughout the entire DeskTop line.

The Dyno2000 has many new options, like
forced induction, that are not supported in
older Desktop products. Even so, a DOS file
export feature has been incorporated into the

Dyno2000 that allows you to ex-
change many simulated engines
with the DeskTop Dragstrip, the
DeskTop Full Throttle Reaction
Timer, and even DeskTop rac-
ing games.

However, to maintain this compatibility,
export limits must be imposed on Dyno2000
engines (except for engines exported to In-
tense Imports which supports all features in
the Dyno2000). The following exports limits
are required:

1) Engines using Forced Induction can-
not be exported.

2) Engines that have Auto Calculate
Valve Size or Auto Calculate Valve
Lift cannot be exported until these fea-
tures are turned off.

3) The Unit system (use the Units menu
in the Dyno2000) must be set to the
US measurement system.

PRINTING DYNO DATA
AND POWER CURVES

The Dyno2000 is capable of printing a
complete list of engine components, cylinder
head airflow data, exact engine test result
values, and 2D graphic curves of several
engine-test variables. Each of these data sets
print on separate pages that comprise a com-
plete 5-page, dyno-test report of the currently-
selected engine. Here is description of each

page:

Windows Print Dialog Box
Frint [21=]

— Printer
Froperties

Hame: 150N Stlus Pro XL+ ESC/P 2
Status: Default printer; Ready

Type: Epson Stylus Pro %L+ ESCAP 2
Wwhere:  LPT1

Cormnmment:

— Print rang Coapie
¢ AllG pages

 Pages  from: |1 o |5

0] Eelention

=

@ ™| Collate
Cancel |

Number of copies:

The print dialog box, accessible from
the File menu, allows the selection of a
printer, access to printer Properties, and
you can select exactly the dyno-test re-
port pages that you would like to print.
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The Dyno2000 will print a complete list
of engine components, cylinder head
airflow data, exact engine test result
values, and graphic curves of engine-
test variables. Each page is shown in
the print preview function available from
the File menu.

Page 1—This page prints the components
selected for the current dyno test. The ap-
pearance of the report is similar to the Com-
ponent Selection pane of the Main Program
Screen.

Page 2—This page displays the cylinder
head airflow data used for the test run.

Page 3—All calculated engine power and
pressures are provided in table form. A cal-
culated value is listed for each 500rpm test
point throughout the full test range (2000 to
11,000rpm).

Page 4—The first of two graphs of engine
output is reproduced on this page (this is the
graph that is setup on the left side of the
Main Program Screen; select the Graph Tab
at the bottom of the Component-Selection
screen to view and setup this graph). Full
color printing is supported.

Page 5—The second of two graphs of en-
gine output is reproduced on this page (this
is the graph that is setup on the right side of
the Main Program Screen; this graph displays
by default). Full color printing is supported.

BUILT-IN CALCULATORS
Note: The built-in calculators and other pro-
gram functions are described in greater de-
tail in the 114-page, on-disk Users Guide,
see page 2 for more information.

The Cam Math Calculator

The basic four valve timing
events (IVO, IVC, EVO, EVC)
are required by the Dyno2000 to
pinpoint when the intake and ex-
haust valves open and close. The Cam Math
Calculator, included in the Dyno2000, in-
stantly converts the lobe-center angle, intake
centerline, and the duration values into VO,
IVC, EVO, and EVC events. These values
can be loaded into the main Component
Selection screen (in the CAMSHAFT
Catetory) and used in the next simulation. In
order for the Cam Math Calculator to deter-
mine all four valve events, BOTH the lobe-
center angle AND the intake centerline must
be available. Many, unfortunately not all, cam
manufacturer catalogs provide sufficient in-
formation to use the Cam Math Calculator to
determine valve event timing. If you have a
catalog that does not provide this informa-
tion, try another cam manufacturer.

Note: You can now obtain cam (and flow
and engine) files from several sources on the
Internet (including the Motion Software
website). The popularity of the Dyno2000 has
engendered “unofficial” support sites that you
may find helpful in your engine development
(Motion Software, Inc., does not endorse,
guarantee, or accept any responsibility for
the accuracy or usability of any of the infor-
mation obtained from “non-official” sources.)

Before you open the Cam Math Calcula-
tor, select the cam timing method from the
Cam Specs @ menu located in the CAM-
SHAFT category on the main Component
Screen. This will establish how the timing
points are applied to the simulated engine.

The Cam Math Calculator is activated by
selecting Cam Math from the TOOLS drop-
down menu or by clicking on the Cam Math
Calculator button on the Toolbar. If the valve
timing points were already entered in the
CAMSHAFT category (on the main Compo-
nent Selection Screen), the Cam Math Cal-
culator will display the lobe-center angle, in-
take centerline, and duration values for the
current cam and accept any changes. On the
other hand, if you have not yet entered valve-
event timing, the Cam Math Calculator will
display blank fields, and allow the input of
centerline, duration, and valve-lift specs. As
you fill in the fields, the corresponding IVO,
IVC, EVO and EVC points will be calculated
and displayed. You may then either accept
the calculated values, transferring them to




Starting The Cam Math Calculator

Tools

Iterator Testing

LCam Math..
Compression Ratio Math...
Airflow Math...

Opens Cam Math Calculator

Open the calculator by selecting Cam
Math from the Tools menu or clicking on
the Cam Math Calculator button in the
Toolbar.

Cam Math Calculator

Cam Math Calculator

Enter Carn Timing Specs @ Seat-ToSeat
Apply
Lobe Center Angle: Intake Centerline: 1020
[cam dearees) [erank degrees) Cancel

Imtak e Duratior: 2780

[crank degrees]

Intake Lift @ Valve: 0500 in

Exhaust Duration: 278.0
(crank degrees]

Exhaust Lift @ Valve: [0.450  in

Calculated Yalve Timing Paints @ Seat-To-Seat

VO (degress BTDC) [31.0 I¥C [degiess ABDC), [67.0

EVD [degrees BEDC): B7.0 EYC [degrees ATDC) [31.0

Enter Lobe Center Angle Yalue Within Range: 0.1 to 360.0 Deg

The Cam Math Calculator allow direct en-
try of cam data from many cam
manufacturer’s catalogs. It also simplifies
changing lobe-center angle, intake center-
line, intake and exhaust duration, and
valve lift specifications.

the CAMSHAFT catetory (on the Component
Selection Screen) by pressing the Apply but-
ton or discard the values and close the Cal-
culator by pressing Close.

The Compression-Ratio Math Calculator

The Dyno2000 includes the ability to di-
rectly enter combustion-chamber volumes,
head-gasket thickness, etc., in order to de-
termine how changes to these components
affect compression ratio and engine power.

After you have specified the bore, stroke,
and number of cylinders for the engine under
test, activate the Compression-Ratio Math
Calculator by selecting either Compression-
Ratio Math from the Tools menu or by click-
ing on the Compression-Ratio Math Icon in
the Toolbar.

When the compression-ratio calculator is

first activated, it defaults to
flattop pistons. This is the sim-
plest model for calculating com-
pression ratio. Flattop pistons do
not require measuring or calcu-
lating the volume of any domes, dishes, or
valve-head clearance reliefs.

Pistons with domes, pockets, or valve re-
liefs complicate the compression ratio issue.
Each of these volumes must be accurately
determined so that the net effect of all “posi-
tive” (domes) and “negative” (pockets, reliefs)
can be taken into account.

First, verify that the calculator is in either
the Flattop Piston or Domed Mode by check-
ing the radio buttons in the Compression Ratio

Compression Ratio Calculator
Current Engine Specs
Appl
Bore: 4251in  CylinderVol  930.32ec  TotalVol 454.2ci
Stroke: 4000 CombustionVoh 97.34ce  Compression Ratio: 1056 Cancel

Compression Raio Volumes

@ £lslon: Flatiop, Without Valve Felels

" Piston - Has Dome, Dish, or Valve Reliefs

(1) Head Chamber Volume: 72.00 o
(2) Head Gasket Bure, 4.320 in
(3) Head Gasket Thickness: 0,035 in

Head Gasket Volume a4 oo

(@) Piston Down Bore @ TDC: [0.047 in

Deck Volume & TOC: 1083 oo

Calculated Mew Compression Ratio

Swept Cylinder Vol 930.32 cc Total Combustion Val: 97.34 o Compression Fatia: 10 56

Compression Ratio Calculator

Cunent Engine Specs
Bore: 4251 in
Stroke: 4.000in

Cylinder Vot 930.32 o Tatal Wal 454 2 ci
Combustion Vol 13989 cc.

Cancel ’

Compression Ratio: 7.65

Compression Ratio Volumes

© Piston - Flattop, Without Valve Reliefs
¥ Piston - Has Dorne, Dish, or Yalve Reliefs
@) (1) Head ChamberVohme:  [78.00  ec
@ ¥
(5 (Z) Head Gasket Bore: [¢320 i
® (3) Head Gasket Thickness:  [0038 i
& ":}1 Head Gasket Yolume: 841 oo
v (&) PitonDownFiom TDC:  [0250 i
£ (8) Volume above pistor: [fz0 e
Deck Yolume @ TDC: 615 oo

Calculated New Compression R atio

Swept Cylinder Vot 93032 cc Total Combustion Yol 80.26 oo Compression Ratior 12.63

When the Compression-Ratio Math Calcu-
lator is first activated, it defaults to the
Flattop Piston Mode. When the Compres-
sion-Ratio Math Calculator is switched to
the Domed Piston Mode, field (4) is rede-
fined and an additional field (5) is dis-
played.



Volumes Area. Next, enter the combustion
chamber volume (in cubic centimeters—cc’s)
in the first (1) Head Chamber Volume data
box. Combustion chamber volume is typically
measured with a burette.

The next two data-entry boxes allow the
program to calculate the head gasket volume.
The data box marked (2) accepts the Head
Gasket Bore diameter. Most head gaskets
have a bore-circle larger than the cylinder-
bore diameter. For gaskets with bore-circle
diameters of odd shapes, estimate the bore
size by averaging the larger and smaller di-
mensions. Next, enter the gasket compressed
thickness in the (3) Head Gasket Thickness
field; the Head Gasket Volume is calculated.

The next entry field (4) accepts different
data depending on whether the Flattop pis-
ton mode or Domed piston mode is selected.
For the Flattop mode, enter the piston posi-
tion (relative to the deck surface) when the
piston is positioned at TDC (positive num-
bers for below the deck; negative numbers
for above the desk).

For the Domed piston mode, (4) Piston
Down From TDC allows you to enter a dis-
tance down the bore (measured from the deck
surface) that positions the highest part of the
piston dome below the deck. Typical values
may be 0.100-inches or 0.250-inches depend-
ing on the height of the piston dome (any
distance is acceptable as long as the entire
dome resides below the deck surface). At this
depth, a direct measurement (with a burette)
is made of the Volume Above The Piston in
the cylinder. The volume is entered in field
(5) Volume Above Piston.

Note: A negative calculated Deck Volume At
TDC indicates that the dome reduces the
combustion space volume and will increase
the compression ratio over a flattop piston.

Airflow Calculator

The Dyno2000 will simulate virtually any
engine with an induction airflow rating mea-
sured at a pressure drop of either 1.5-Inches
of mercury (InHg), widely accepted as the
standard 4-barrel airflow pressure-drop rat-
ing system, or at 3.0-InHg, the standard pres-
sure drop used to rate 2-barrel carburetors.
For those instances where an induction sys-
tem, injector, or carburetor was flow tested at

a different pressure drop, or if
you would like to convert flow
values from one pressure-drop
rating to another, the Dyno2000
includes an Airflow Math Cal-
culator that easily performs these conver-
sion functions.

Note: A pressure drop of 1.5-inHg is
equvalent to 20.3-inH,0.

The Airflow Math Calculator has three
basic modes: convert to 4-Barrel Standard,
2-Barrel Standard, and No Fixed Standard.

Activate the Airflow Math Calculator by
either selecting Airflow Math from the Tools
drop-down menu or click on the Airflow Icon
located in the Toolbar. Select the desired Air-
flow Ratings Standard from the three “radio
button” choices provided. Entered the mea-
sured airflow and pressure drop in the Known
Airflow category (you can switch between
Inches-of-Mercury [Hg] and Inches-of-Water
[H,0] buy clicking on the appropriate radio
buttons). The calculated airflow will be dis-
played in the Airflow Rate field. You can move
to any of the previous fields (by clicking in
them or using the Tab or SHIFT-Tab keys)
and make changes to analyze their effect on
the calculated airflow. At any time, you can
click on the Apply button to load the new
calculated airflow into the Component Selction
Screen (in the Induction Flow field). Alter-
nately, you can press the Cancel button to
discard all entries and leave any previously
entered values intact.

Airflow Calculator

Aiiflow Math Calculator

Airflow Ratings Standard
" Mo Ratings Standard

Apply
Cancel

€ 2-Banel Rating at 3.0inHa Pressure Diop
& 4-Barel Rating at 1.5 inHa Pressure Diop

Krawar Airflowy Calculated Airflow

Pressure Drop Linits Pressure Diop Units
8 Inches Water (inH20) " Inches Water (inH20)
" Inches Mercury (inHg) wp| 1 dnches Mercuy finHal
Airflowy Airflow

Pressure Drop: [30 inHZ0 Fressure Diop: inHg

Airflow Rate:  |822 ofm Aiflow Rate:  B766  cfm

The Airflow calculator can convert any
measured airflow and pressure drop to
any other pressure drop and equivalent
flow.

Motion Software, Inc., 535 West Lambert, Bldg. E, Brea, CA 92821-3911
Voice: 714-255-2931, Fax: 714-255-7956, www.motionsoftware.com



